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the Timeline Viewing area 
 

 
 

1. This is the timeline Viewing Area (graph). Your timeline Entries will be placed in this area. 
[Note: that when zooming your entries may be outside this viewing area and not visible. 
           See the Positioning the viewing area section below] 
 

2. Above the viewing area you will see dates above the major gridlines. 
[Note: for minor grid spacing, see just below the viewing area on the right] 
 

3. An entry’s left edge lines up with its Starting year and its right edge lines up with its Ending year with the 
exception when the viewing area is zoomed. Then you will notice the character(s) ◄ & ► around your entry’s 
title, these signify that the entry extends beyond the viewing area. (notice the Creation entry and see that it has 
the ► after its title. 
 

4. When you hover your mouse over an Entry a popup will appear for a few seconds. The top line(s) show the 
Starting and Ending dates. The text below the dates is text that you added to the Description/Info area for your 
entry. You can learn more about this in the Add/Edit section below. If you click on an Entry, then the program 
will display a small window with full content of your Description/Info that you have entered. See Using the 
Timeline Info Window section below. 
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Positioning the viewing area 
 

 
 

A. To zoom in on a time range, use the Zoom scroller. As you change the zoom value, you will see the number of 
years being displayed to the right of the scroller. 
[Hint: when you hover your mouse over the viewing area and hold the Alt key down and roll your mouse wheel 
it zooms your timeline in small increments. (Shift + Alt + roll the wheel scrolls in large increments)] 
 

About increments of the zoom scroller: 
 As with any windows program there are 2 basic increments (Large or Small). When you click to the left or right of the 

position marker  the scroller reports to the program to change the zoom in Large increments. When you click on 
either arrow   at the ends of the scroller, it reports to change using Small increments. The zoom scroller 
dynamically changes the Large/Small increments according to the length of years (e.g. if 2000 year are left, the 
increment will be Large increment will be 500 years. If 90 years are left, then the increment will be 10 years). 
 

B. When you have zoomed, the horizontal scroller will become visible. This scroller allows you to move the 
Starting year that appears on the left edge of the viewing area. The number of years set by the zoom will 
remain the same (thus pushing the Ending year on the right edge of the viewing area to a value 
accommodating the zoom setting). 
[Note: the Large increment will change to the number of years that you currently have showing in the viewing 
area (whatever you set with the zoom scroller). 
[Hint: when you hover over the viewing area and hold the Ctrl key and roll your mouse wheel, this scrolls the 
timeline horizontally in small increments. (Shift + Ctrl + roll the wheel scrolls in large increments) 

 
C. If your timeline has more entries than will fit into the viewing area, you will see the vertical scroller appear. This 

allows you to position the timeline entries to be visible in the viewing area. 
[Note: when you save your timeline, the Vertical position, Horizontal position, & Zoom setting are saved with 
your timeline file. Thus when you open the timeline file you will see exactly what you had showing when you 
saved the file] 
[Hint: when you hover over the viewing area and roll your mouse wheel, this scrolls the timeline vertically by 
the size of a timeline entry. (Shift + roll the wheel scrolls in small increments)]] 
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D. At times you may have difficulty locating a specific entry in your timeline. This tool (Move to person/event) will 

assist you in finding your entry. Click on the arrows on the right side of the box to locate your entry. Then click 
on the Go button. The program will change the Starting year of the graph to the starting year of your entry (if 
not visible in the viewing area, the program may alter the vertical position and/or the zoom setting). 

 
E. If you know a specific year that you want for the Starting year of the viewing area, you can use this tool (Move 

to year). Simply enter the year you want and then click the Go button. (for years BC, you can enter a negative 
number like -700 for 700 BC, or you can enter 700 bc). 

 
F. Under the viewing are you will see the Years displayed and Minor grid spacing. These aid you in reading the 

timeline. They are also shown when exporting the timeline, this aids those whom might be viewing your 
timeline. 

 
 
 

Using the Info Window 
 

 
 
   When you click on an Entry in the viewing area, the program will open the Timeline-Info window (as shown above). It 
displays what you have entered in the Description/info area for your timeline entry. The info window is used when you 
want to view the information for your entry and the popup (when hovering over an entry) does not show all your info or 
the popup showing time is too brief.  
   It is advised to move the info window to a location outside of the main timeline window so that it will not be hidden 
when you move back to the main timeline window. To move the info window just use your mouse to grab the top of the 
info window and drag it to a new location on your desktop (same as you would any other window on your desktop). 
   While the info window is visible, you may click an any entry in your timeline to show that entry’s info in the info 
window. 
 

A. The info window will display your Title and the dates for your Entry. If no Creation dates are found then the 
creation date line is left blank. 

 
B. This area of the info window displays your Description/Info that you entered for your timeline entry. Use the 

scroll bars to reposition as you read. 
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C. The program allows you to change the vertical size of the info window. Simply grab the bottom of the window 
and drag to change the vertical size. The horizontal size is fixed to accommodate the export size as well as the 
contents of the popup’s when hovering over an entry. 

 
D. To hide the info window you can click on the OK button. 

[Note: if you click in the viewing area of the main timeline window (not on an entry) the program will hide the 
info window for you.] 

 
E. When Adding/Editing the Description/Info text, you can control what is visible in the popup when the user 

hovers over the entry. The program looks for the first line which is 5 or more hyphens (minus signs) in a row. 
When it finds this it signals the program to abbreviate what is shown in the popup view, it also appends a line 
under the popup’s text with more… . 

 
 

The Menu bar 
 
Hint: most operations will signal success with a short sound. 
 

 
 

New 
Allows you to start a new Timeline. 

Open 
Allows you to open an existing Timeline 

Save 
Allows you to save the currently visible Timeline. 

SaveAs 
Allows you to save the currently visible Timeline to a new filename. 

Export to Word 
Allows you to export all or part of your timeline to a Microsoft Word document. 
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Copy Screen to Clipboard 

Copy using Current Bg 
Allows you to copy the Timeline image to the clipboard using the current background color. 

Copy using White Bg 
Allows you to copy the Timeline image to the clipboard using a white background color. 

Copy using Gray Bg 
Allows you to copy the Timeline image to the clipboard using a gray background color. 

Custom Bg Color 
Allows you to copy the Timeline image to the clipboard using a custom background color. A popup color 
selection window will appear. Simply select the background color that you want and click the OK button. 

Custom Bg/Grid Color 
Allows you to copy the Timeline image to the clipboard using a custom background color and a custom major 
grid color. Two popup color selection window will appear in succession. The first is for selecting the 
background color and the second is for selecting the major grid color. Simply select the background color that 
you want and click the OK button. 
[Note: the minor grid color is whatever you have set it to from the Tools menu.] 

Copy Full height 
Toggle how much of the vertical area of the timeline is copied to the clipboard.  
   When checked, all that is showing from the visible area to the bottom of the timeline. By using what is visible 
at the top, allows you to control copying a portion of the time to the bottom. 
   When unchecked, what you see in the viewing area is copied to the clipboard. This is the default area copied 
to the clipboard. 
   Horizontal areas not shown in the viewing area are not copied to the clipboard. To copy areas not shown 
horizontally, use the zoom scroller to reduce the zoom, thus showing more of the horizontal portions of the 
timeline in the viewing area. 

Print 
(Not yet implemented) Allows you to print your timeline (the viewing area). 
 

Exit 
Allows you to close the Timeline program. 
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Add Timeline Entry 
Allows you to add a new timeline Entry to your timeline. (See Add/Edit section below for more details) 

Edit Timeline Entry 
Allows you to edit a timeline Entry in your timeline. (See Add/Edit section below for more details). This will take you to 
a window which will allow you to select from all your timeline entries. 
[Note: you could skip this step by right-clicking on a timeline entry in the viewing area and clicking on Edit Timeline 
Entry.] 
 

Delete Timeline Entry 
Allows you to delete a timeline Entry from your timeline. 
[Note: you could skip this step by right-clicking on a timeline entry in the viewing area and clicking on Delete Timeline 
Entry.] 

Copy from other timeline 
Allows you to copy entries from another timeline, thus adding them to your current timeline. This is very handy in that 
you will not need to re-enter timeline data for an entry more than once. 

Move Timeline Entry 
Allows you to move a timeline line Entry’s location vertically in your timeline. 

Edit Timeline Note 
Allows you to change the Timeline Note for your timeline. The Timeline Note allows you to document general 
information concerning your timeline. (e.g. the purpose of the timeline, details to gleaned from the timeline, & where 
your collected your timeline information). This is unique for each of your timelines. 
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Change Timeline colors 

Change Background color 
Allows you to change the Background color for your timeline. This is saved with the timeline. 

Change Major Grid color 
Allows you to change the Major Grid color for your timeline. This is saved with the timeline. 

Change Minor Grid color 
Allows you to change the Minor Grid color for your timeline. This is saved with the timeline. 

Show Vert Overflow 
Toggles whether to show an Entry’s title when the entry width is too short to display the entry’s title. By default this is 
checked. When this is enabled, copied images will have this overflow labels shown in the image. 

 

Show Minor Grids 
Allows you to hide the Minor Grids. By default the Minor Grids are shown. 

Allow scrolling below entries 
Allows you to scroll verticall above/below the First/Last timeline entry. 
 

 
 

Manual (pdf) 
Not ready at this time 

Instruction Videos 

Introduction to the program 
Opens your browser to this video which tells you the basics about this program and how to use it. 

Add/Edit Tools 
Opens your browser to this video which tells you how to use the Add & Edit tool. 

Current Timeline Notes 
Shows the Timeline Notes. This does the save action as when you click on the About  button below the viewing area. 

About 
Standard about feature found in most windows programs. It displays the Author, Copyright, Version number, & other 
relevant information about the Timeline  program. 
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Right-click on Timeline Entry 
When you right-click on a timeline entry in the viewing area, you will see a popup menu: 

 
 

Edit Timeline Entry 
This will open the Edit window directly for the entry that you clicked on. It is similar to clicking on the menu bar Tools-
>Edit Timeline Entry, but it bypasses the window where you would select a timeline entry. 

Delete Timeline Entry 
This will allow you to directly Delete the timeline entry that you right-clicked on. It is similar to clicking on the menu bar 
Tools->Delete Timeline Entry. 

Move to Person/Event 
This will allow you to position the timeline entry that you right-clicked on to the left edge of the viewing area. It is similar 
to using the Move to Person/Event tool below the timeline. It save you from having to scroll the Move to Person/Event 
box. 
 
 
 
 

Using the Timeline Info Window 
When you click on a timeline entry in the viewing area, the program will open the Timeline Info window (as shown 
below). In it you can view full information for that timeline entry. It is strongly suggested that you drag the window to a 
location away from the main timeline window so that it will not get covered up by the main timeline window. 

 
 

• While this window is open, you can click on any of the other timeline entries in the viewing area and the 
information in this window will be replaced.  

 
• To hide this window you can: 
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o Click on the background area of the Viewing Area of the main timeline window 
o or click the OK button in the Timeline Info window. 

 
A. You can resize the Timeline Info window by grabbing the bottom edge of the window with your mouse and 

dragging downward. 
 
 
 
 

Add/Edit 
The Add  & Edit  windows are identical with the exception that when the Edit window appears it will be populated with 
that Entry’s settings. You get to this window via the menu bar from Tools. 
 
The Add window is where you enter a New Entry for your timeline. And the Edit window allows you to alter the settings 
for an existing Entry to your timeline. 
 

 
 
The suggested order of entering your timeline entry’s data is: (A) Entry type; then (B) Entry name, this is displayed in 
your timeline; then (C) Entry’s Start & End dates; then optionally (D) Entry Description/Info; then optionally (E & F) 
Entry color & positioning; then you would click on the OK button (G). 
 
A. You will first want to select the Entry’s type  (one of the 4 available types: Person, Event, Spacer, or Circle). Notice 

that when you select an entry’s type that other fields within the Add/Edit window will become enabled/disabled 
depending on the entry type selected. 

 
Person : as the type label suggests, this timeline entry is used for a Person. The Start & End year field will reflect 
something about that person (e.g. when they were born & when they died, or if they were a king when they 



Timeline User Manual 

Copyright © 2013 Steve Clark Page 10 of 22 
 

reigned). A person timeline entry will be shown as a rectangle aligning its left/right edges to match the Start/End 
year. You will be able to change the rectangle’s color shown above by step (E). A person entry will also use the 
OverFlow labeling when the rectangle is too short to display the person’s name. 
[Note: that the Creation dates fields become enabled for this Entry type.] 
 
Event : as the type label suggests, this timeline entry is used for an Event. The Start & End year fields will be 
enabled. If the event has a starting and ending year you should not use the Invert setting. The event will be shown 
as a rectangle when the Invert setting is not checked. When the Invert setting is checked the entry will be shown 
as just the text from the name field, but the text will take on the selected background color selected by step (E). If 
your event does not have an ending year, then enter the same year that you entered for the starting year (e.g. 
Starting year = -930 and Ending year = -930). 
[Note: you can cheat a little to get the Ending year to appear by not force the Inverted length to represent it, by not 
checking the Invert setting and entering an Ending year, then click to set the Invert setting. The Ending year will 
still be shown in the Ending year field even though it is disabled.] 
 
Spacer : this entry type is used to provide a gap between 2 timeline entries. All other fields are disabled for this 
entry type. Often after entering this entry type you will want to use the Move Timeline Entry tool to reposition it (the 
gap) between your timeline entries that you want your gap in between. 
 
Circle : this entry type will appear as a circle instead of a rectangle. If you use the Align setting (mention more in 
detail below for Circle Entry Settings) then your timeline entry’s Name will be shown where you have specified 
around the circle. You can also imbed 1 or 2 characters within a circle entry which show up inside the circle. 

 
B. Name: your Entry’s name is what is shown in the timeline. It may appear within a rectangle (Person/Event entry) or 

beside a Circle entry. It will also be shown when viewing the Timeline Info window. 
 

C. Start Year : enter the starting year here. Important: for years BC, please enter them as negative numbers. 
 
End Year : enter the ending year here. Important: for years BC, please enter them as negative numbers. 
 

D. This is where you enter specific information pertaining to your timeline entry. You will be able to customize the text 
and add image(s) here. (See section below Editing Desc/Info details). This is optional, you don’t have to enter 
anything if you don’t want to. But this is a key feature of the Timeline program. It allows you to assign detailed 
information to Person/Events with your timeline. The data entered here shows up when a user clicks on your 
timeline entry (in the Timeline Info window). It is saved with your timeline. 
 

E. In this area you can alter various settings for your entry, depending on the entry type. The Color for Person/Event 
allow you to set the background color for their rectangle (exception: Circle & Event-Inverted use this as text color). 
[Note: If you select Not Visible, the program will hide the entry’s rectangle and text, but leave a gap. I use this 
mostly to extend the timeline’s total time. (e.g. stretch the length of time that the timeline will show; this allows me 
to add padding to display some things)] 
 

F. Not shown in the above image is the Position Alignment Override. This allows you to force a timeline entry to be 
placed horizontally aligned to another timeline entry. 
 

G. Once you have finished adding or editing an entry’s settings, click on the OK button and the program will update its 
information. This does not save it to the file, but updates internal information for displaying. So you will need to 
save your updated timeline using File->Save (or SaveAs) from the menu bar. When in the Add window you can 
continue to add new timeline Entries; this has the advantage to remembering your last entry adding settings. Or if 
you are in the Edit window you will see an extra button along the bottom for selecting another entry to edit. 
 

H. When you are done adding or editing, press this button to return to the timeline. 
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Edit Timeline Entry 
This appears under Tools  in the menu bar. It allows you to edit the settings for an already existing timeline entry. 
 
 

 
 
[Hint: you can bypass this by using Right-click Timeline Entry] 
 
A. In the list box, locate the timeline entry in which you want to edit and click on it. 

[Hint: you can double click on it to bypass step B] 
 
B. Now click on the Edit  button and the program will open the Add/Edit window and populate it with the timeline 

entry’s setting. 
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Delete Timeline Entry 
This appears under Tools  in the menu bar. It allows you to delete one or more timeline entries. 
 

 
 
[Hint: you can bypass this by using Right-click Timeline Entry] 
 
  1. In the list box, select one or more timeline entries that you want to delete from the timeline. 

[Note: you cannot delete all the timeline entries here. Use New from the Files menu.] 
[Hint: hold the Ctrl key down as you click to select multiple entries.] 

 
a. Notice as you select timeline events to delete that they are listed on the right side of the list box. 

 
b. Notice you are shown how many timeline events that you have under the list box. 

 
  2. Once you have your entries selected, press the OK button to delete them. 
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Copy from other timeline 
This is a powerful tool which allows you to copy one or more timeline entries from a different timeline and place them in 
your current timeline. It copies all of each copied timeline entry’s settings as well as Desc/Info to your current timeline. 
If you have entered a lot of specific information along with images, then you do not have to re-enter all that info. Just 
use this tool to copy it from an existing timeline. 
 
 

 
 
1)  In the Current Timeline list, click on the entry where you want the new entries added. 
 
2)  Now click on how you want the new entries added relative to your selected location in the Current timeline list. 
 
3) Now click on the Select File button and open the other timeline file that you want to add entries from. 
 
4) Now select which entries that you want to merge into your Current Timeline list. 
    Hints: 

• you can select more than 1 entry in Other Timeline list. 
• you can select sequential items by, click on 1st item then hold the Shift key down and click on the last item. 
• you can select random items by, holding the Ctrl key down and click on each item you want. 

 
5)  Press the Copy Entries button to merge your selected items into your Current Timeline list. 
 
 
Other things to note: 
• There is ONE level of Undo available after you have copied your entries. You will notice that the Undo button 

becomes available after copying your entries. 
• You can open other Timeline files and copy from them after you have copied from the first other timeline. 
• You cannot copy entries which have the same name from one timeline into your current timeline list. 
• Don't forget to save your timeline when you return to your main timeline window! 
      [it would be wise to use the SaveAs method and save your combined timeline to a new Timeline file.] 
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Move Timeline Entry 
This is found under Tools  in the menu bar. It allows you to change the position of a timeline entry within the timeline. 
 
 

 
 

A. In the Current Timeline list box, click on the timeline entry that you want to move. 
 

B. Now click on the arrow(s) button to move your timeline entry’s location. 
 

C. When you get your entry where you want it, then click on the OK button. 
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Edit Timeline Note 
This is where you add/edit the general note for your timeline. This note is shown to the user when they press the 
About  button under the timeline. This note is very useful for the users to see: 

• Your explanation of what your timeline is meant to show them. 
• Where you got the information for your timeline. 
• Whatever other information that you want to relate to the user viewing your timeline. 

 

 
 
Enter you information in the text area (you can also insert images), then click on the OK button. 
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Entering text in Desc/Info and Timeline Note areas 
 
 

 
 

A. New button. It will erase everything in the edit window. 
 

B. Load  File button. It will allow you to load a RTF (Rich Text File) into the edit window. 
 

C. Save File button. It will allow you to save the edit window to a RTF file. 
 

D. Load Image button. It allows you to load a picture file and pastes it to where your cursor is located in the edit 
window. 

 
E. Standard Cut/Copy/Paste buttons. These work with text that you have selected in the edit window. 

 
F. Standard Bold/Italic/Underline buttons. These work with text that you have selected in the edit window. 

 
G. Highlight button. Works with text that you have selected in the edit window. It changes the background color 

for your selected text. The box to the right shows you the color of selected text where the cursor is located. 
 

H. Standard Font button. Works with text that you have selected in the edit window. You can change the font 
type, style, size and color. 

 
I. Shows you the font size where the cursor is located and its color. 
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Export to Word 
This is selected from the Files  menu. It allows you to export different parts of your timeline into Microsoft Word. This 
can be very useful for creating: 
 

• Handouts for your Sunday school class or study group. 
• Create your own documentation for a given study or subject 
• For Logos 4/5 users you can create PB’s (Personal Books) for your library from the created Word docx. 

 
 

 
 
 

1. Export Everything : adds everything usable in your timeline to the Export Items list (see step 7). Sometimes 
this may be easier to use than manually using buttons in steps 2-5 and then use right-click on Export Items to 
remove unwanted items. (see also Export: right-click menu below) 

 
2. Add TL Image : add the timeline graph image (similar to what you see in the viewing area, but it’s the full 

timeline height).  
 

3. Add Table : allows you to create a table from your timeline entries and then adds it to the Export Items list. 
(See Exports: Table editor below) 

 
4. Add TL About : adds your Timeline Note to the Export Items list. 

 
5. Add Entry Desc : allows you to select which timeline entry Desc/Info values to add to the Export Items list.   

(See Exports: Desc/Info selector below) 
 

6. Clear Export List : removes all items that you have added to the Export Items list. 
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7. Export Items list : this shows you what you have selected to export to the Word document. You may right-click 

on items in the list to see the popup menu (see Export: right-click menu below) 
 

8. Export : after you have added all items you want to the Export Items list, you press this button to have the 
program send your items to a Microsoft Word document. 

 
9. Cancel : this becomes enabled after you have pressed the Export button. It allows you to abort the export. 

 
10. Status area : after pressing the Export button you will see info telling you what is being exported as well as a 

progress bar. 
 
 

Export: right-click menu 
In the Export Items list, when you right-click on an item you will see a popup menu as shown below: 
 

 
 

Edit this item 
This menu item will only be enabled for Table items. It will open and populate the Export: Table editor. When 
you finished editing the table info, it will not add a new item, but merely updated info about the table that you 
originally right-clicked on. 

Delete this Item 
Deletes the item from the Export Items list that your right-clicked on. 

Move Item Up 
Moves the item that your right-clicked on up one position in the Export Items list. 

Move Item Down 
Moves the item that your right-clicked on down one position in the Export Items list. 
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Exports: Table editor below 
When you click on the Add Table  button or right-clicked on a table item in Export Item list and clicked on Edit this 
item , the edit window below will show up to the right of the Export Items list. This editor allows you to design a custom 
table to be exported to Word. You can design: 
 

• A Heading that you added about your custom table. 
• Which columns you want and what timeline entry data is entered in the rows under this column. 
• Which timeline items that you want used as rows info under the columns. 

 

 
 
A. Table Title : In the box type the title that you want to appear above your table in the Word document. 
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B. Columns : this is where you decide which timeline entry values are used as columns and their arrangement 
horizontally. 

 

 
 

1. Enter the text that you want as a heading for this column. 
[if you click to check Use Default Heading, the program will generate default column heading 
text.] 

 
2. Select which timeline entry setting that you want used for this column (e.g. Name, Start Year, 

End Year, etc) 
 

3. Click here after selecting steps 1 & 2, then click on the Add  button and the program adds your 
info to area 4 for your viewing. 

 
4. Shows what you have selected for columns so far. 

 
5. Click here to clear everything that you have added to area 4. 

 
6. This is a shortcut to adding just (Name, Start Year, End Year) only to item 4. 

 
After you have entered column info into item 4, you can right-click on items in to (delete or rearrange 
them) as shown below. 
 

 
 
You will need to click to select the item’s row first, then you can right-click on it. 
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C. Rows : this is where you decide which timeline entries are used as rows under the columns that you have setup. 
You also have control over the vertical order that your timeline entries appear in your table. 

 

 
 

1. Select which timeline entries that you want shown in your table. 
[Hint: you can select more than one item at a time, hold the Ctrl  key down as you click 
         Or drag over the items with your mouse.] 

 
2. After selecting item(s) in step 1, click on the Add  button to add them to your list in item 3. 

 
3. This shows you a list of items that you have selected. 

 
4. Click here to erase all the items in your list (step 3). 

 
5. This is a shortcut to add all your items to your list (step 3). 

 
After you have entered row info in area 3, then you can right-click on items in area 3 to (delete or rearrange 
them). 
 

 
 
You will need to click to select the item’s row first, then you can right-click on it. 
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Exports: Desc/Info selector 
When you click on the Add Entry Desc  button, the edit window below will show up to the right of the Export Items list. 
This editor allows you to select which timeline entries that you want their descriptions/info section added to your 
Microsoft Word document. 
 

 
 
Select which timeline entries that you want their descriptions/info sections added to Microsoft Word document. These 
will show up in area 3. 
[Hint: you can select more than one item at a time, hold the Ctrl key down and click or drag over them with your 
mouse.] 
 
After selecting items in step 1, click the Add  button to add them to your list in area 3. 
 
This area shows items that you have selected in steps 1 & 2. 
 
When you click this button it will clear items that you have selected in area 3. 
 
Note: 
After you have selected items and clicked on the Add Desc/Info  button, the program will add each of your selections 
as individual items to the Export Items list. So to remove any of these added items from the Export Items list you will 
need to right-click on them one at a time and select Delete. 
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